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1 Introduction 

Survey Master(SM) is professional Android-based surveying software developed by 

ComNav Technology. The setup Wizard makes you easily configure the GNSS, and 

with the User-friendly interface with smart menus, objects and graphics you can 

collect field data through Topo survey/Auto survey/Area Survey/Feature Survey, 

Static and PPK, also stake points/lines/arc/CAD. Moreover, Survey Master provides a 

convenient way to import/export surveying data.  

1.1 Installation environments 

Survey Master can only run in Android operating system, and the android device 

specification should be at least or better than the ones listed below: 

⚫ CPU: core 2.1GHz(currently support ARM cortex only) 

⚫ At least 4G RAM 

⚫ Android System version: ≥4.2 

⚫ Screen: 4.5 inches 

⚫ Screen resolution: 960*640 

⚫ Hardware: Bluetooth, Wi-Fi/GPRS 

1.2 User Interface 

Survey Master has user-friendly interfaces, which provides you a convenient and 

effective surveying experience. This version has two interface styles: Blue and 

Colorful. You can choose a style what you like in settings. 

This version adds a new interface theme and there are two themes you can choose: 

classic theme and simple theme. You can go to Project->Settings->Set theme to set a 

proper theme.  
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Set theme                                  Classic theme                        Simple theme 

Blue style: 

    

Colorful style: 

      

The More interface stores the uncommon function, you can long press the icon on the main 
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interface and click   to put the function you will not use frequently. And you can also long 

press the icon in the More interface and put the function you use frequently in the main 

interface. Besides, you can drag the icon to change their order.  

   

For Simple theme, there is only one page, there are some default functions in this 

page, you can add the functions which you use frequently from More page.  

In the top of the page, there are Wizard, Project, Datum, Device. In the middle of 

the page,  

  

Following function instructions are based on Classic theme. 

 

1.2.1 Project interface 

Click this to connect a device, you can go 

to Device to disconnect the current device, 

if you use Simulated Device, the Device 

function can’t be used, you need to go to 

disconnect the device. 
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The interface mainly includes Project, Coordinate system, Import/Export and Cloud.  
 

• Wizard: Guide the whole workflow 

• Project: Build/Open/Delete a project 

• Datum: Select and manage the datum 

• Element: Points manage; check points measured, key in known points and other 

function 

• Surface: Surfaces management 

• Code: Management codes in list 

• Basemap: Import DXF/SHP file as Basemap 

• Import: Import points file (including CASS, CSV, TXT and DAT formats) 

• Export: Export Grid Coordinates and Geodetic coordinates (based on WGS84 or 

Local), stake points/lines and detailed survey points, you can also export DXF 

and KML format  

• Rinex convert: Support to convert cnb file to Rinex format in your controller 

• Features: Features manage; check points/lines/polygons what you measured in 

Feature Survey 

• Cloud: Login cloud to backup project, datum, work mode 

 

1.2.2 Device interface 

This interface is related to setup the GNSS in RTK mode, and check the receiver 

information. 
 

• Connection: Connect receiver 

• Rover: Setup receiver work as rover 

• Base: Setup receiver work as base 

• Antenna: Antenna manage; check the information of antenna  

• 0183 Output: Configure NMEA output via com port or BT 

• External radio: Configure external radio 

• Device Info: Show firmware, hardware, status and so on. 

• Position Info: Show receiver, base station and satellites information 

• Register: Check register status 

• Static: Log raw data 

• H-terminal: Send commands to receiver 

• Debug data: Save data output from BT 

• Mock Location: Share Survey Master location to controller 

• Update firmware: update firmware for the receiver whose current firmware 

supports this function, only supports *.bin format. 

 

1.2.3 Survey Interface 
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This interface contains all survey modes, such as the most used function Topo survey, 

stake out and road function.  

 

• Topo survey: Measure points 

• Mapping survey: Record control points 

• Detail survey: Show local gird coordinate and LatLon coordinate  

• Auto survey: Automatic measure points by time or distance 

• Stake point: Stake out points 

• Stake line: Stake out lines 

• Stake Arc: Design curves and stake out curves 

• Stake CAD: Import dxf or dwg file; choose points/lines to stake out 

• Area survey: Get area result by measure points 

• PPK: Dynamic data collection 

• Road design: Design road 

• Road stake: Stake road 

• Road store: Road elements 

• Feature survey: Measure point/line/polygon features 

• Surface stake: Stake out surfaces 

1.2.4 Tool Interface 

The interface mainly includes site calibration, grid shift and cogo function. 
 

• Site Calibration: Transfer the WGS84 coordinates to local grid coordinates 

• Grid Shift: Once change Base coordinate during one project, need do this 

• Area calc: Used for calculate polygon area by measured points 

• Earthwork Calculation: Calculate the earth volume to dig or fill based on surfaces. 

• COGO: Calculate points/lines/angle 

• FTP: Share controller files to pc wirelessly 

• E-mail: Send files to e-mail 

1.2.5 Status information  

The status bar is showing the receiver status. 

 

 

    

 

 

 

Receiver status: Single/Float/Fixed/Base 

Receiver Battery 

Press to go base/rover setup  

D: Diff delay, press to check 

position info 

Used/track satellites: press to go sky view 

H: H.RMS, V: V.RMS 

Click to check positioning 
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⚫ Status Bar 

 

The icons and their descriptions are as follows: 

 

Icon Description 

 

Indicates the receiver battery power, calculation method is (A+B)/2,  
A: battery power of compartment A; B: battery power of compartment B; 
You can click this icon to check more details. 

 

 

When you use the internal radio or external radio mode, in the controller 
which is connected to rover, this icon will show, and it represents the 
battery power of the base. 

 N/M 
M: number of the satellites tracked;  
N: number of the satellites used. 

 Radio mode 

 
PDA CORS mode 

 
Internal GSM mode 

  

The positioning status and their descriptions are as bellows: 

 

Status Description 

Searching The receiver is searching the satellites. 
Single(Red color) Single positioning solution. 

Float (Red color) The whole week ambiguity is not fixed. 

Fixed (Black color) The whole week ambiguity is fixed, high accuracy. 

Base The base is setup successfully. 
D:*** The diff delay, * represent the diff delay value 

H: …, V: … Horizontal RMS, Vertical RMS 

 

Tip:  If the status keeps searching when the receiver is outdoors, pls check if the receiver register 

is expired; or you can try to update the firmware, if these methods cannot solve the issue, pls 

contact our support. 

 

 

 
 

1.2.6 Settings 

You can find the Settings in the Project page, or you can go to sidebar to enter Settings. 

 

⚫ Auto connect: If you check on this option, then when your restart the software, it will 

Go to Sidebar Scan to: 

Connect Bluetooth 

Add Datum 

Register receiver 



Survey Master Quick Guide 

10 
 

automatically reconnect the device before restarting the software.   

⚫ Automatically enter kboard mode: This function is used in K8 kit device, for more 

information, pls refer to the Chapter 18. 

⚫ Mock Location: This function can share the receiver position to third party software, for 

more information, pls refer to Chapter 13.7. 

⚫ Main interface display coordinates: If you check on this option, then when you connect 

to a device, the coordinate information will be displayed in the main interface. Default 

is off. 

  
⚫ Display: Coordinate display order, you can choose “E, N” or “N, E”, this will be used in 

the main interface coordinate display and other functions which will display coordinate. 

But this cannot change the coordinate display order of the information bar in the survey 

and stake interface, whose order can be changed in the Information settings. 

⚫ Voice: Voice is used for sound prompts when clicking on measuring points and stakeout; 

Speech will  be applied to some functions that require voice prompts 

⚫ Language: Survey Master now supports 18 languages, including Chinese, English, 

German, French, Spanish, etc.  

⚫ Hot key: You can set Volume+ (-) as Null, Measure, Previous point, Next point.  

Null: means no settings, default is null. 

Measure: means to survey the point. 

Previous point: skip to the previous point in the stake functions. 

Next point: skip to the next point in the stake functions. 

⚫ Units: set units for the surveyed points and export data. 

Length: supports meter, international feet, US survey feet 

Angle format: supports degree(°), dd°mm′ss.sssss″ 

Export decimal: 0.0, 0.00, 0.000, 0.0000, 0.00000 

⚫ Work range: supports single project and all projects, default is single project. 

Quick code: The quick code created in single project can only be seen in single project, if 

you set as all projects, then the quick code created in single project will be hidden. If 

you set as all projects, then your current quick code will be shown in all projects.  

CAD file: If you import a CAD file in Stake CAD, single project setting will apply in current 

project, if you set all projects, then the all projects can show this CAD file. 

⚫ Set theme: You can set theme for Survey Master, including classic them and simple 

theme. And set Icon style: Blue or Colorful. 

⚫ Screen orientation: Supports Automatic, horizontal screen, vertical screen. 
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1.2.7 Sidebar 

Click the icon in the upper left corner of the main interface, you will get the sidebar 

information.  

 

1.3 Workflow 

This figure shows the workflow of your survey through Survey Master. 

 

2 Wizard function 

Follow the Wizard, you can quickly learn the general workflow of Survey Master, also 

you can quick start your survey by this function no matter you are experienced one 

or new user. 

Sinognss Technical Service Hotline: Get support from 

this hotline. 

Cloud: For more information, pls refer to Chapter 

13.1. 

Help: Click this to get help document for Survey 

Master, only supports English language now. 

Feedback: You can send the errors or abnormal 

features, suggestions for improvement to us in this 

way. 

Share and rate: You can use the QR to share the 

Survey Master to others or share to other software. 

About: This shows some information for current 

version, click version to get release log.  

Settings: For more information, pls refer to Chapter 

1.2.6. 
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In Project menu, tap Wizard. 

First step is for Project, click Select to go into Project interface to create or select a 

project. For detailed information, you can refer to chapter 3. 

    

Second step is for Bluetooth connection, click Select to go into Bluetooth connection 

interface. For detailed information, you can refer to chapter 4. 

               

Third step is for Work mode set up, click Select to go into QuickSetup interface to 

start your receiver as Base/Rover. For detailed information, you can refer to chapter 

5. 

If start your receiver as Rover, then you can start work directly of Topo survey or 

Stake out. 
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If start your receiver as Base, after setting Base mode successfully, there will be a 

Prompt. 

YES: will disconnect with base and go to Connection interface; 

NO: will keep connecting with base and go to Device interface. 

     

3 Create a new project 

Click Project, set project name and select project datum.  
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If you want to start work with receiver, you should select one project with datum 

information. In Project interface, you can click Create to add a new project or click 

Open to open the previous project. It also supports to backup your project file by 

uploading your Cloud account, and download from it. If you delete the projects 

accidently, you can recover them from Recycle Bin. 

 

Survey Master supports to order the project by date and time, in order or reverse 

order. 

 

If you have added one project, you can click View or click the project name in the 

main interface to check the current project details, including Project name, store 

path, and datum parameters. Click the QR to share your datum information to 

others. Besides, click Edit to change the datum parameters, also, you can change in 

the Datum interface.  

 

You can select a code list when you create a project, for more information, pls refer 

to Chapter 13.9. 

 

To edit datum parameters, SM supports three methods: Use last project, Datum 

store, Scan QR code. 

   
• Use Last project: If you have added datum before, then you can choose to use 
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the datum of last project for current project. 

• Scan QR code: Support to get the datum from other users. 

• Datum store->Select a Predefined datum: You can select datum directly from 

the list. Survey Master currently has 49 countries datum and will add more 

afterwards. 

Create a User defined datum: If you cannot find datum you want in the list, follow 

instructions below to add one: select Source ellipsoid, Target ellipsoid, Projection for 

your datum, and even seven parameters, geoid model based on your request.  

   

Source ellipsoid: Source ellipsoid is the ellipsoid whose GPS measured data has 

no conversion. Generally, the source ellipsoid is WGS84 coordinate, because the 

coordinate directly obtained by GPS receiver is WGS84 coordinate. 

Target ellipsoid: This is the ellipsoid where the coordinates used in the 

measurement, depending on the actual situation of the coordinates. 

Tip1: if asked username and password for seven parameters, enter admin admin 

Tip2: For H.RMS and V.RMS, it will show after do Site Calibration. 

 

Share Datum via QR code: press project name, it will generate a QR code about 

datum parameters. Users can use the Scan function to get the datum. 



Survey Master Quick Guide 

16 
 

   

 

Upload Project/Datum to cloud: sharing project with cloud. 

   

4 Connection 

After creating a new project, switch to Device, tap Connection. You can connect 

Survey Master with ComNav GNSS receivers. Or choose Simulated device/NMEA 

Device/Controller GNSS.  

• ComNav: There are four connection types: Bluetooth, USB OTG, Serial Port, 

Remote.  
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Bluetooth: After connecting ComNav receiver, you can check some information of 

receiver (like firmware version) in Device Info. And some functions are only available 

for specified device.  

    

After connected successfully, the bottom will show the positioning status. 

Tips: If you failed to connect with receiver through Survey Master, you can just follow prompt 

info to go into the device Bluetooth setting interface to make sure Bluetooth paired 

successfully. Sometimes you need restart the receiver or Survey Master. 

USB OTG: Using USB, OTG and D-SUB9(RS232) to connect with OEM board. 

Serial port: Support to connect with Android-based Tablet PC with OEM board inside.  



Survey Master Quick Guide 

18 
 

   

• Simulated Device: Simulate connecting Survey Master. On this model, some 

functions will not work.  

   

• Controller GNSS: Survey Master can use the controller internal GNSS, which is a 

good choice for GIS data collection. 
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• NMEA Device: Any other brand receivers which can output NMEA data can 

connect with Survey Master, in this model, some functions can’t be configured, 

like base settings, and some of the rover settings. If other brand receivers want 

to work with Survey Master, should do as followings:  

1) Configure your receiver on other GNSS software, make sure it can receive 

differential data and get fixed, meanwhile, output NMEA message: GPGSV, G 

PGGA, GPZDA and GPGST.  

2) Disconnect with other GNSS software, then connect with Survey Master, it 

should be fixed, and you can do general survey and stake. 

 

5 Quick Setup your receiver 

In Survey Master, you need only one step to start your receiver: Choose work mode-> 

Apply. 

There are some default work modes, three for Base and two for Rover. Choose one 

mode and long press, you can check the detailed information. If the default work 

mode suits for you, you can just click Apply to start your receiver. Usually, you need  

to add one mode yourself.  

Modify antenna parameters for receiver 

Connect BT 
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5.1 Start your receiver as Base 

5.1.1 Internal Radio mode 

This mode uses internal radio to transmit the correction data from Base to Rover. 

You need to set Base and Rover with same protocol and frequency. 

The following steps give an example of internal radio transmission.  

   

 

• Protocol: Supports Transparent, MAC, South or TT450s for Base transmission 

• Frequency: select a channel or customize a frequency, the range of frequency is 

400-480 MHz  
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• Auto base: Once you start the Base, the receiver will automatically get current 

coordinates and broadcast correction data. 

• Fix position: Once you start the Base, you need enter known coordinate or get a 

current coordinate.  

    
 

• Library choose: Select a known point from library (Element) 

• Receive: Survey a point with GNSS 

After start base successfully, there will be a prompt, click Yes to disconnect the 

receiver and jump to the connection function or click No to back to Device interface.  
 

Choose one work mode and long press, then you can do the following functions. 
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• Detail: You can check the detail information of the work mode. 

• Copy: Copy the existed work mode, and paste to rename it.   

• Modify: If you find that the work mode you added has some error or just want 

to change based on the current work mode, you can click Modify button to 

change it.  

• Delete: You can delete the work mode that you don’t need. 

• Generate QR code: This is used to share the work mode QR code to other people 

or you can save the QR code picture for backup, users can use the Scan function 

to get the work mode.   

• Cloud upload: Upload your work modes to Cloud for backup. 

• Cloud download: Download the work modes from Cloud. 

Tip: Delete and Modify are not available for default work modes.  

5.1.2 External Radio mode 

This mode uses external radio to transmit the correction data from Base to Rover. 

You need set Base and Rover with same protocol and frequency. 

The steps to start external radio mode is similar with internal radio mode, but you 

need select the protocol and frequency on the external radio, not on Survey Master.  
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If you use CDL3/CLD5 external datalink, you need to check on CDL3/CDL5 button, 

and the settings are below: 

 

Protocol: Support Transparent, TT450S, MAC and South. 

Power: Supports 2w, 5w,10w, 15w, 20w, 30w. The higher power is, the more 

consumption will be. 

Channel: Support to customize, for normal CDL3/CDL5, the minimum frequency 

interval is 0.05 MHz(50 KHz), you should select the same channel on Survey Master 

and CDL3/CDL5, for more information, pls refer to CDL5 User Guide. 

Air baudrate: For ComNav GNSS receivers, the air baudrate is 9600, if you want to 

work with ComNav GNSS receivers, pls set it 9600. 

Baudrate: This option is to set the baudrate of lemo port, if you set 38400, you need 

to choose 38400 to connect CRU, or freset the receiver to clear the settings, then the 

baudrate will restore to 115200. 

 

If you use CDL7 external datalink, you need to check on CDL7 button, and the 

settings are below: 

 

Protocol: Only supports Transparent. 

Power: Supports 2w, 5w,10w, 15w, 20w, 30w. The higher power is, the more 

consumption will be. 

Channel: Support to customize, for normal CDL7, the minimum frequency interval is 

0.0125 MHz(12.5 KHz), you should select the same channel on Survey Master and 

CDL7. 

Air baudrate: For ComNav GNSS receivers integrated with lora modem, the air 

baudrate is 11000, if you want to work with ComNav GNSS receivers, pls set it 11000. 

Baudrate: This option is to set the baudrate of lemo port, if you set 38400, you need 

to choose 38400 to connect CRU, or freset the receiver to clear the settings, then the 
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baudrate will restore to 115200. 

 

Tips:  

1. If you want to setup the PDL or other external datalink, you need to check on the Setup CDL, 

and set the protocol, power, frequency and baudrate, then check off the Setup CDL button, 

and click confirm.  

2. CDL3/CDL5 external datalink can work with the normal receivers, for example, all the K7 

platform T seires receivers, and T300/+, T30 E; CDL7 can only work these receivers which is 

integrated with Lora modem, like N3 receivers and N5 receivers for K8 platform.  

   

    

5.1.3 Internal GSM mode 

This mode uses GPRS (internet data) to transmit the correction data from Base to 

Rover. You need insert a SIM card to Base, set the Base to log on server (with static 

IP address), and the Rover receives the correction data by Ntrip protocol. 
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The following figures show an example of Base configuration with internal GSM 

transmission. 
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Tip: ComNav Technology provides a free static server address 211.144.120.104:8888, anyone 

can upload CORS data so long as abide by the agreement.  

5.2 Start your receiver as Rover 

This chapter shows how to start receiver as rover with internal radio, internal GSM 

and PDA CORS mode. 

5.2.1 Internal Radio mode 

Select the same protocol and frequency with Base receiver, then the receiver status 

will turn single to fixed.  

The following steps show an example of internal radio.  
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5.2.2 Internal GSM/PDA CORS mode 

For internal GSM need insert a SIM card to receiver, for PDA CORS need make sure 

controller can access to Internet.  

You should enter the server IP and Port. In addition, enter User (login name) and 

Password to get Source List. 
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The protocol supports CORS, SinoGNSS, TCP. 

SinoGNSS: This is the exclusive Ntrip protocol of ComNav, if you choose this protocol, then 

you will not be asked to enter the username and password. 

CORS: This is a common Ntrip protocol, you need to set the username and password. 

TCP: This is used to directly obtain the corrections transmitted by TCP protocol.  

Transfer corrections: This function can only be used for N5 (K7 platform), T30 IMU. You can 

use this function to transmit the corrections from the base via internal radio, which needs 

you to install the whip antenna on your current receiver and another rover. 

 

 

 

 

 

 

Press to get source list and select mount point 

Press to modify the APN for SIM card 

Add your CORS info to list, press to select 

 

1021-1027 message is only available for PDA 

CORS mode, the message is used for datum 

correction for CORS. 
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Tip: L-Band is only for PPP function, using PPP function can get the station coordinates 

directly, and there is no limit with the distance of stations, the accuracy can be up to 3-5cm.  

6 Survey-field Data collect 

This section describes the basic survey functions of Survey Master, including Topo 

survey, Mapping Surface, Auto survey, Area survey, Feature survey and stakeout.  

6.1 Topo survey 

Click Topo Survey-> enter point name, ->click  to start or stop collecting data. 

⚫ You can quickly change antenna height in the survey interface. 

⚫ Tap Elem to check point coordinates. 

⚫ Tap Layer to show the layers: google map/google satellite/DXF/SHP 
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: Click this to show the whole points on the interface. 

: If the arrow is out of sight on the interface, you can click this to locate the receiver 

position, then the arrow will be shown on the interface. 

⚫ Graphic survey: Tap the graphic button, after completing survey, will directly 

show the graphic on the map, you can export the graphic survey results as 

*.dxf  format in Export interface.   
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⚫ Fast survey by pressing Code: Tap the code in nine panels, will survey the point 

directly.  

Tip: Go into code function to modify code list, then you can choose the code what you want to 

use in nine panels. For detailed information, you can refer to chapter 12.9 

   

⚫ Recover deleted points in Recycle Bin. 
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⚫ Save PPK data 

In the settings, if you check on Save PPK data button, then will save PPK data while 

doing RTK. It is designed for the harsh environment where the receiver is not stable 

to get fixed. When you back to office, you can process the PPK data to get a fixed 

solution. 

After check on the Save PPK data button, when you click survey button, it will 

prompt to save a PPK file. You can click File button to build a PPK file, click Refresh 

button to check the current PPK file size. If you choose another PPK file and click 

Open button, it will prompt you that Open this file will stop current surveying.   

   

Tip: There is no button to stop the file recoding, when you open Survey Master and 

reconnect the receiver next time, it will continue last recoding.   

6.1.1 Tilt Calibration 

There are three tilt calibrations for ComNav Technology receiver.  
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⚫ Magnetometer: T30/T300plus receivers which are based on K7 platform;  

⚫ IMU modem: N5 (K7 and K8 platform), N3 (K8 platform) etc.  

⚫ Laser receiver: The new generation receivers which are integrated laser modem. 

Tilt survey option will appear when receiver supports for tilt survey, it is available for 

ComNav Technology T30 and T300 Plus GNSS receiver (K7 platform), but T300/G200 

does not support tilt survey. 

When the pole tilts within 30°, the built-in sensor based tilt measurement system 

precisely calculates the actual offset according to angle, which can not only meets 

the requirement of high precision measurement, but also relieves the users from 

continually checking whether the pole is plumb. 

              

1. Check Tilt Survey option: Go into Topo survey—Settings—Tilt Survey 

   

T300/G200 

T30/T300 

Plus(K7) 
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• Tilt tolerance: the value is relevant with the antenna height, if antenna height is 

2m, the tilt should be less than 1m (tilt angle should less than 30°) 

• Magnetic field strength: default value is 70, You can check current field 

Magnetic strength: Device→Position Info. Please kindly adjust it, the bigger 

value of magnetic field strength is, the more increase of measure error will be. 

• Calibration interval: supports 20 days, 90 days, 180 days, 365 days, if you choose 

20 days, it means tilt calibration will expired after 20 days. 

2. Calibration 

If calibration expired or you first use the receiver, tap Calibrate and follow the 

guidance until succeed. During operation, make receiver can search the satellites. 

 

   

In survey interface, you can find the bubble and angle value shows the pole you tilt. 

Magnetometer calibration: 

⚫ Operate as the picture 

shows. 

Accelerometer calibration: 

⚫ Mount the receiver on a 

leveled tribrach. Be sure 

the receiver is definitely 

in a horizontal state. This 

step is very important for 

receiver to get high 

accuracy. 
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The angle should be less than 30°, for more accuracy, angle less than 15°will be 

better. 

 

Tips: In the Tilt Survey, there are three options: Disable Bubble, eBubble, Tilt compensation, 

Disable Bubble: not use bubble or tilt during surveying; 

eBubble: will show bubble only on the survey interface after do magnetometer calibration 

and accelerometer calibration, this will help you to check the bubble position on the pole, so 

you can check the bubble on the interface instead of on the pole; but this doesn’t use 

calibration parameters during surveying, so you should keep the bubble centered to get high 

accuracy. 

6.1.2 IMU calibration 

When the pole tilts within 60°, the built-in sensor based IMU precisely calculates 

the actual offset, which accuracy can up to 2.5 cm 

                         

N5 

T300 
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Open IMU: Go into Topo survey—click the IMU button, follow the guidance in 

interface to complete it. During operation, make receiver search satellites and get 

a fixed solution. 

   

            Open IMU                     Confirm the pole height            Shake the receiver                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                  

After initialization, it will show IMU in service. Go back to survey interface, you can 

find the bubble and angle value. For more accuracy, angle less than 60°will be 

better.  

     

Tips:  

1. Do not shake or rotate the receiver violently, otherwise you need to re-initialize. 

2. After IMU initialization, do not keep the receiver still for a long time, usually when the receiver 

keeps still for about 15 minutes, then the accuracy of tilt survey will not meet the request, it will 

prompt you to shake the receiver. 
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3. The K7 receivers with IMU, when you do IMU initialization, you need to rotate the receiver 90 

degrees, the K8 receivers with IMU, if your OEM firmware is higher than 601AJ, then no need to 

rotate 90 degrees. 

4. If you meet some problems in initialization, it will give you some tips on the screen, you can just 

follow the tips, when the problem is solved, the initialization will go on. 

5. If you can’t do IMU initialization successfully, pls freset the receiver and do IMU initialization 

again. Tighten the pole, shake the receiver at a bigger angle and slowly. 

6. Confirm the antenna height, default is 1.8m, it will prompt once, next time when you do 

IMU initialization, it will not prompt again. 

 

6.1.4 Tilt offset 

Tilt offset function is different with Tilt survey. It is available for ComNav Technology 

GNSS receiver, Not only T30, T300 Plus, but also T300 and G200. 

Need you to ensure the bottom of the pole is fixed, and measure 4 points from 

different angle or azimuth. It will use these 4 points to calculate the tilt point. 

     

Tip: We have tested this function, but the accuracy of tilt point is not good and less than tilt 

survey. We will take our effort to solve this problem. We suggest you to use tilt survey if you have 

high-precision requirements. 

6.1.5 Offset Point 

When you measure a point that cannot be approached in the field, you only know 

the distance and azimuth from the point to the current position, you can use the 

Offset Point function to calculate the coordinate of the unknown point, and save the 

point to the Element. 
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 H.distance: The horizontal distance from unknown point to the current position; 

 V.distance: The horizontal distance from unknown point to the current position; 

 Azimuth:  Taking the current position as the origin, starting from the true north 

of the current position and clockwise to the angle between the unknown point. 

6.1.6 Indirect point 

This function is used to calculate the coordinates of a point at a certain distance from 

the known point A and the known point B. 

       
 

 You can enter the point A and point B coordinate manually, or you can click the 

 to select from Element, or click  to survey the point; 

 Enter the L1 and L2 for distance from point A to the unknown point P and 

distance from point B to the point P; 

 Determine whether the unknown point is to the left or right of the AB line, and 

the direction is from A to B.  

 Click Compute to get the unknown point P coordinate, it will be shown under 

the interface, click Save to enter the point name and save to the Element.  
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6.2 Control survey  

Control survey is also called topographic control survey, used for topographic 

mapping, including horizontal control survey and vertical control survey. Generally, 

control survey is gradually encrypted between high-level control points. 

 

1. Control survey should be carried out under the control point network. 

2. The accuracy of the control points is measured by the median error relative 

to the adjacent control point. 

3. The density of the control points is determined according to the terrain, the 

instrument and the measurement method used. 
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Control survey: 

1) Click Survey->Control survey, enter the control survey interface; 

2) Name: Set a name for the control point; 

3) Code: Same as Topo survey, set a code for the control point; 

4) Antenna: Set antenna height; 

5) Delay: Set the delay time between two rounds, and can check the process bar 

in Reset; 

6) Smooth: This is similar with the occupation time, there are 2 numbers on the 

behind of the process bar, the first number shows the status of the smooth 

point collection, the second number shows the total number of the points 

involved in the smoothing, for example, if you set the smooth number to 10, 

the receiver will collect 10 times, and take the average of these 10 times 

results as the smooth point; 

7) Round: One round will get one smooth point, there are 2 numbers on the 

behind of the process bar, the first number shows the current measurement 

round, the second number shows the total number of the measurement 

round during the control survey, if you set the round number as 3, the 

receiver will collect 3 smooth points, and take the average of these 3 smooth 

points as the final result, called control point; 

8) Reset: During the reset, the receiver will pause the measurement point, after 

one measurement round, the receiver will undergo a reset before starting 

next measurement.  

9) Start: Start Control survey, after smooth, round, reset, the control survey will 

be completed. 

10) Setting:  

a) Plane tolerance method: includes overall and each component (dN, dE) 

➢ Overall: combined dN and dE, and set tolerance for the combination, 

generally, the combination is square root. 

➢ Each component (dN, dE): set tolerance for dN and dE respectively. 

b) H.RMS: Plane tolerance of mapping survey, the default is 0.02, unit: 

meter. 

c) V.RMS: Set height tolerance of mapping survey, the default is 003, unit: 

meter. 

d) Rounds number: Set the round number, the default is 3. 

e) Round H.RMS: the average plane tolerance of the smooth points between 

two rounds, the default is 0.02, unit: meter. 

f) Round V.RMS: the average vertical tolerance of the smooth points 

between two rounds, the default is 0.03, unit: meter.  

g) Sample interval: The sampling time interval between two smooth points, 

the default is 1s. 

h) Fixed: When check on this button, then it won’t let you to survey the 

point if the status is not fixed; When check off this button, you can survey 

a point even it is not fixed.  

i) Smooth number: The number of smooth point number within a round, 
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the default is 10, and no less than 3. 

j) Smooth precise: Set the tolerance for the smooth measurement within 

one round, the default is 0.02, unit: meter. 

11) SMOOTH POINT:  

a) σ: The error value within one round; 

b) Round: Display the smooth point data in each round in the measurement 

process; 

12) Export the report: You can export the control report after completing the 

control survey, for more information, please refer to Chapter 12.2. 

6.2 Auto survey/Area survey/Detail survey 

⚫ Auto survey: automatic and continuous survey by Time or Distance.  

  

 

⚫ Area survey: compute area directly after getting points.  

Press , it will show the coordinate information, press , it will show the 

area result, press  , it will show the shape on map. 
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⚫ Detail survey: show both local coordinate and Latitude/Longitude.  

 

6.3 Feature survey 

For feature survey, you can survey points, lines, polygons. After survey the point of 

line or polygon, you can real-time drawing them into a graph. This can help you see 

the features clearly. If you use the code that you add, the feature will show the same 

color and style of the code. 

1. Choose the code and go survey: 

You can select the code of point, line and polygon to go feature Survey. After 

measured, the feature will store in Features. 
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2. Real-time drawing: 

Click , it will prompt to complete the line or polygon survey. The line and polygon 

will show the same color and style of code in the feature survey interface. 

Tip: If you want to draw a line or polygon, you need to survey all the point in the line and polygon. 

Be sure the points are all the same code. After these, you can automatically draw. 

 

3. Check and manage the features: 

Click Features in the Project interface, you can delete or see the details of the 

feature what you selected. Including check the point of feature and preview it. 

    

 

There are new added functions in Feature Survey. 

1. Delete point on the screen, you can delete the point by choosing the point on 

the screen. 

: Finish the current feature survey, 

the feature will be stored in the 

Features; 

Undo: Undo the last measured point; 

Delete: Delete current surveying 

feature. 
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2. Calculate the distance between two pints.  

Click the Distance icon on the right side of Feature Survey, then the icon will be 

highlighted. Click Distance icon again or click Exit to exit the distance calculation 

mode.  

 

Follow the instruction on the screen to calculate distance or exit calculation mode 

choose the first point one the screen, 

Second point: choose the second point on the screen, then it will get the distance 

information between these points you selected. 

                                                      

3. Draw graphics using the existed points 

Use the graphics on the left side of Feature Survey, supports to draw line segment, 

polyline, polygon, circle, rectangle, etc. All these drawings can be exported in the dxf 

Choose one point on the screen, when the point is 

chosen, then it will be highlight on the screen. 

Delete: delete this point, it will be deleted on the 

screen and Element, but you can recover it from the 

Recycle bin. 

Exit: Exit the edit mode, the point will cancel the 

highlight display. 

Undo:  Undo the selected 

point, you can choose the 

first point again. 

Exit: Exit the distance 

calculation mode. 
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file export. 

    

Tips:  

1. For line segment, when you choose two points, it will finish one line segment 

automatically, same with rectangle, circle, square and arc.  

2. For the polyline and polygon, you need to complete the garphic drawing manually.  

3. Take the polyline for example, choose the Polyline on the screen, then choose the points 

on the screen to draw line.  

4. For these graphics drawn by the user, you can choose them on the screen, then edit their 

color and type, or delete them. 

5. Choose one drawing on the screen, this drawing will be highlighted. 

    

6.4 Stake points/lines 

Undo: Go back to the previous 

step 

Completed: Finish the 

drawing. 

Exit: Exit the creation mode. 

Modify: Modify the styles, 

color and size. 

Delete: Delete the drawing on 

the screen. 

Exit: Exit the edit mode. 
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6.4.1 Stake points 

Go into Stake point interface, click to choose a point and tap Stake. Survey Master 

provides a navigation map when staking points/lines. If you are close to the target 

point enough, it will alarm you based on the alarm range you set. 

   

    

Various navigation info choices 
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Tip: keep your receiver vertical to the ground. 

For N5 receiver and T30 IMU receiver, you can use IMU staking function. In the IMU 

staking, you can open IMU function, and don’t need to keep the receiver vertical to 

the ground, and the tilt angle supports maximum to 60 degrees. 

6.4.2 Stake line 

For staking line, click  -> add line (Two points or Point + Azimuth + Distance) -> 

click  -> Choose one line and click Stake. It will show all the lines you added. The 

default method to stake is “To line”, press method to choose a method you want.  

   
 

Choose the direction method: 

North/South/East/West 

Left/Right 

Add: Add a point manually  
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6.5 Settings for Survey/stakeout 

Here show all settings for Topo survey/Auto survey/Area survey. 

 

  

 

 

• Fixed: only fixed result can be saved; 

• Duplicate name: allow point name same; 

• RMS: point accuracy need higher than the value; 

• Auto save: save points to Element directly; 

• Code measure: quick measure by nine-panel codes;  

• HRMS, VRMS: threshold for points accuracy; 

• Save PPK data: you can save PPK data while doing 

RTK, and later you can process the PPK data; 

• offset radius: point cannot offset bigger than the 

value during measure; 

• Occupation time: measure times for one point; 

• Point stepsize: for point name; 

• Stake alarm: alarm when close to target point 

• Stake point survey point name prefix: This is used to 

set the prefix for the survey point when you srake 

the point. 

• To line: show shortest way to find a 

point on line;  

• To station ID: stake points on line by 

defined interval;  

• Distance of 2 points: show distance 

of current location to the line’s start 

point and end point; 

• Segment: Stake on line by defined 

segment value. 

•  

Slide to check more information 
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• Direction guide: 3 methods showing guide for stake 

out; 

• Electronic compass: Use controller compass during 

stake out; 

• Auto centered: Map will go to current location after 5 

seconds; 

• Keep centered: Map will go to current location after 1 

second; 

• Display survey points: will show all survey points on 

map; 

• Display stake point: will show all stake points on map, 

used in all stake functions. 

• Safe mode: When you check on this, there will be a 

icon in the Survey and Stake interface. If you in the 

harsh environment, the receiver coordinate is not 

correct, you can click this icon to reset the RTK 

resolution; 

• Display feature color based on date: This is used to 

change the feature color based on date, and it supports 

the date before yesterday and yesterday, now it can 

only changes the surveyed features.  

Stake Alarm: 

This is used to set the alarm when stake point, it has three 

classes, when the receiver approaches from the L3 range to 

the L1 range, the prompt sound frequency will gradually 

increase.  

 L1 range is 0.00- 0.02m, when the receiver is in this range, 

the alarm will sound twice per second. This class is open as 

default.  

L2 range is from 0.02m to the value you set, this value should 

be bigger than 0.02m, when the receiver is in this range, it 

will sound once per second. Default is closed. 

L3 range is from the value you set in the L2 range, the end 

value should be bigger than the L2. Default is closed. When 

the receiver is in this range, it will sound once per two 

seconds. 

You can close L3 range, and when you close L2 range, L3 

range will be closed automatically. 
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Safe mode 

• Disable bubble: not use bubble or tilt;  

• eBubble: show bubble only; 

• Tilt compensation: apply compensation during 

tilt. 

• Display map: for showing digital map or 

satellite map 

• Display Basemap: when you import CAD 

basemap in Basemap, you can display it in 

the Topo Survey and Stake point surface. 

When you check on Display map and Display 

Basemap, then it will show digital map or 

satellite map and basemap at the same 

time. 

• Font size: This is used to set the font size of 

the basemap 

• Survey boundary: You can set an area, if you 

are beyond this area, it will disable 

measuring points. 
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These are the settings for information display in 

survey interface. 

Display option: Items which can be shown in the 

survey interface, 8 items are the most. 

Other option: Items which cannot be shown in the 

survey interface. 

N, E, Z: plane coordinates. 

B, L, H: latitude, longitude, ellipsoid height. 

Status: receiver RTK solution status, includes 

searching, single, float, fixed. 

To base: Distance from receiver current position to 

the base. 

Δd:  Distance from receiver current position to last 

surveyed point. 

Δh: Height difference from current position to last 

surveyed point. 

Slope ratio: The ratio of vertical distance H to 

horizontal distance L, between current position to 

last surveyed point. 

These are settings for information display in stake 

interface. 

Fill/Dig: The height difference between stake point 

and current position. 

East/West: The direction instruction to the 

east/west according to stake point and current 

position. 

South/North: The direction instruction to the 

south/north according to stake point and current 

position. 

Forward/Back: The direction instruction to the 

forward/back according to stake point and current 

position. 

Left/Right: The direction instruction to the 

left/fight according to stake point and current 

position. 

Distance: The distance from current position to the 

stake position. 

Azimuth: The azimuth between current position 

and stake point. 
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7 Stake Arc 

Click Stake Arc in the Survey interface, you can design your polyline, curve and stake 

it. 

1. Add the polyline: 

    

Tip: Now can only select point from element to add a polyline. 

2. Add the curve: 

These are the settings for information display in 

Road Stake and Stake Arc. 

Cross: For road stake, left/right is cross, the cross 

is negative, which means it is on the left side of 

the road center line, positive means on the right 

side of the road center line. 

Longitudinal: For road stake, forward/back is 

Longitudinal deviation, and the longitudinal 

deviation is negative, which means it is behind the 

target point, positive means it is front the target 

point 

Drag the icon to change the items display order 

Add the items to display option or remove them 

to other option 
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• Stake: Select a curve to stakeout and enter the Stake Arc interface 

• Detail: Select a curve to view more details of it 

• Settings: Set the distance of spacing 

• Preview: preview the selected curve 

• Add: add a curve what you need 

• More: 1. Import: Import curve data; 2. Export: Export curve data; 3. Delete: 

Delete the selected line in the line library; 4. Clear data: Clear all data in the line 

library; 

Three types of curve: 

When you add a curve, you can add Arc, Spiral, Circle. For arc and circle line type, 

there are some methods to design it 
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3. Stake: 

Select a polyline or curve in the line library and click Stake to enter the stake 

interface. 

              

 

East/West/North/South: Direction from current to target point. 

D: Distance between the current and the target point. 

Dig: use dig or fill to represent elevation difference from current to target point.  

8 Stake CAD 

1. It’s in the Survey interface, click Data -> Import to add the *.dxf or *.dwg file or 

change to another *.dxf or *.dwg file. 

⚫ Stake points: Use arrow to select points 

    +  
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   : Click to change the background color, including black, gray, white.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                  

: Input the point what you selected to stake points library 

: Click to stake out  

: Quickly switch to the closest stake point according to the current position of 

device 

: Input key word of the point or line, click the result then jump to the 

corresponding position. 

: Click this when you stake point, but it won’t survey the stake point to Element.  

Tip: If you want to see the staked point, you can check on the Display stake point button. 

Save: Save the CAD file to the new dxf file; 

Layer: Check the CAD file layer. 

When you choose one point or line of the CAD file, you can do the followings: 

Delete: Delete this point or line, then click Save to save as a new file. When you exit 

the Stake CAD, the delete operation will not be saved to this current file.  

Detail: Check more information of the line what you selected  

• Current location 

• The staking point 

• Distance to staking point 
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Save all points: This can  save the line endpoints of the selected line to the Element, 

the points are saved as the map selected point. 

Stake: Choose one point in the list to stake. 

⚫ Stake lines: Directly select line on the screen to stake, support to stake 

straight line, ellipse and elliptic arc.  

Setting: Set the method of stakeout (like specified distance, line segment), offset, etc. 

➢ Start Pt mileage: If you set the start Point mileage as 5m, then final mileage will 

plus 5m. 

➢ Reverse mileage: If check on this button, you will stake from the other side of 

the line.  

➢ Stake by coordinate: including specified distance, line segment and key node.  

(1) Specified distance: Stake the line at a specified distance, for example, if the 

line is 40m, you set the specified distance as 8m, then you will stake the line at 

8m distance every segment. 

(2) Line segment: For example, if you set the line segment as 4, then you will 

stake the line at 4 segments, every segment length is the same. 

(3) Key node: You will stake the line at key node, like start point, end point, and 

inflection point.  

➢ Offset: If you set the offset 5m, then you will stake the line 5m away from the 

line you choose. Plus and minus represent different sides of the line. 

 

Here are some examples in the following pictures: 
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Start Pt mileage: 0; 

Reverse mileage: off; 

Offset: 0; 

Line segment: 5 

Start Pt mileage: 0; 

Reverse mileage: off; 

Offset:0.5m; 

Method: Line segment 

Start Pt mileage: 0; 

Reverse mileage: off; 

Offset: -0.5m; 

Method: Line segment 
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Start Pt mileage: 0; 

Reverse mileage: on; 

Offset: 0; 

Specified distance: 20m 

Start Pt mileage: 0; 

Reverse mileage: off; 

Offset:0; 

Method: Key Node 

Start Pt mileage: 0; 

Reverse mileage: off; 

Method: to line 
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2. Settings: 

 

Background color: support white, gray and black 

Language: Turn on the button, it can support any language 

9 Stake Surface 

You can stake the elevation using the design surface, then you can choose the fill or 

excavate according the stake result. 

1. Go to Survey->Surface Stake, if you don’t open a surface before, then it will jump 

to the Surface interface; 

2. If the current position is not within the range of the design surface, it will show 

“Out of Surface!”; if the current position is within the range of the design surface, 

it will show the fill or excavation value; 

3. There are two methods to stake the elevation, you can use the elevation from 

the Design surface, or you can use the Design elevation to get the fill or 

excavation value; 
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9 Static survey and PPK 

Survey Master provides multiple choices of survey methods for users, and the 

following sections provide a brief introduction of PPK and static survey. 

9.1 Static survey 

Static survey is commonly applied for control points, which requires millimeter 

accuracy. After connecting with Bluetooth, you can record static data to your 

controller directly, if your receiver’s SN is T31XXXXX or your receiver is K8 receivers 

(needs firmware supported, the firmware can’t be lowered then 1.4.0 OS firmware 

and 609N5 GNSS firmware),  

⚫ Save the static data in controller 

 

⚫ You can enter File name, Station name, 

Antenna height, Sampling -> Click Start 

record, the recorded raw data will be 

saved in the corresponding path. 

 

⚫ The raw data is in .cnb format, you can 

transfer to RINXE format through CRU 

software.  
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⚫ Save the static data in the receiver  

If you want to record static data to receiver memory, you can also control by Survey 

Master instead of long pressing the static button on receiver, this function is 

available for T300 GNSS receiver（SN:T31XXXXX） and K8 platform receivers. 

1) T300 GNSS receiver（SN:T31XXXXX） 

  
2) K8 platform receivers 

   

Station name: The static will be stored in this folder,  

Record space: Default is 600 MB, this is set record space for the current static file. 

Antenna: Set the antenna height and measure type, it will be recorded in the static 

file. 

Sample interval: Choose sample frequency, supports 0.05s, 0.1s, 0.2s, 0.5s, 1s, 2s, 5s, 

15s, 30s, 60s. 

File split: Choose file split, support every 5\10\15\20\30 minutes or 1\2\4\24 hours 

Click to check 

the detail. 

⚫ You can also set parameters to receiver, 

including station name, elevation, 

antenna height and sampling. 

 

⚫ The raw data is in .cnb format, you can 

transfer to RINXE format through CRU 

software. 



Survey Master Quick Guide 

62 
 

to save a file and file split manually, default is manual. If you select 24 as file split, it 

will create two data file when it occurs to 24 o'clock (UTC Time). One is from start 

time to 24 o’clock, another is from 0 o’clock to end time.  

Data format: Support CNB\ Rinex3.02\Rinex2.10 

Loop: When storage is full, Yes means delete earliest data and store continually, No 

means stop recording 

Mode: Support manually and automatically recording mode. 

  

In Status interface, you can check the static record status, and static settings. 

In File interface, you can check the static files by day/week/month. You will find the 

folder, and the static data is in the specific folder. Long press the static data, choose 

to delete the file. 

 

9.2 PPK 

Click to change the data 

range. 
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PPK (post processing kinetic) is the unique function of survey master, which is used 

for post-processing dynamic measurements.  

It also needs two receivers to work together, one work as Base to record static data, 

and another one work as Rover as shown below. 

1. Click PPK in survey interface -> Build a PPK file 

2. Go Settings, configure PPK based on your requirements 

3. To get stable epoch, click  to initialize ->  to start PPK survey 
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10 Road 

To stake road alignment, first you need design the road, including the horizontal 

alignment, vertical alignment and cross-section.  

   

10.1 Road Design 

Survey Master can use two methods to define an alignment: PI and C/L. 

• PI refers to point of intersection, which mainly use point coordinates to define 

the alignment;  

• C/L method is more popular, which use element parameters such as line length 

to define the alignment. 
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Click  to add a new road; 

Click  to edit the selected road; Click  to delete a road file. 

Click  to show the selected road the map interface. 

Click  icon to upload/download a road file from cloud. 

 

10.1.1 Broken chainage 

Broken chainage refers to the phenomenon of discontinuity of pile numbers caused 

by local changes or section measurement. There are two main situations, one is that 

the front stake is larger than the back stake, and the other is that the front stake is 

smaller than the back stake.  

 

Classification of broken chainage has two types: 

 

The first type, the front pile number is greater than the back pile number, for 

example: K112+943.305 = K112+900.001, and there will be duplicate piles. In this 

case, it is called a long chain. The distance between two long chains is the difference 

between the two piles, 43.304 meters. 

 

The second type, the front pile is smaller than the back pile, for example: 

K115+309.227 = K115+320.001, there will be a discontinuity in the stake. This 

situation is called a short chain, and the distance between two short chains is also 

the difference between the two piles, 10.774 meters. 

 

To sum up in a short sentence, it is: if the pile number is repeated, it is a long chain, 

and if the pile number is broken, it is a short chain. 

 

Survey Master supports long chain, short chain, and supports multiple broken 

chainages at the same time. It is recommended that the user enter the broken 

chainage first before entering other parameters to avoid changing the broken 

chainage later and affect other parameters. Of course, you can also enter the broken 

link later. 

 

When you enter the broken chainage, it is entered as real number, for example, 

K1+234.000 = K1+238.000, the mileage before the broken chainage, you need to 

enter 1234, the mileage after broken chainage, you need to enter 1238; 

K112+943.305 = K112+900.001, the mileage before the broken chainage, you need 

to enter 112943.305, the mileage after broken chainage, you need to enter 

112900.001.     
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 Import: Import broken chainage data; If there is already broken chainage data in 

the list, when you click Import, it will prompt that” The original data will be 

cleared before importing data.  Are you sure to continue importing?”  

a) CANCEL: then the data import will be canceled;  

b) OK: it will clear the existed broken chainage data and jump to the broken 

chainage data import interface.  

      
Survey Master supports four kinds of broken chainage:  

a) Standard broken chainage data(*.dll); 

b) Broken chainage data from Road Star software(*.xls); 

c) Broken chainage parameters from Surveyor software(*.xls); 

d) Broken chainage parameters from Surveyor software(*.txt) 

You should choose a type of broken chainage, import data or exit the import 

interface. 

 Save: When you add or modify the chainage, you can click Save to save the data, 

the broken chainage data will be saved in the path: Sinognss/sm/Road.  

 Add: You need to enter the mileage before broken chaniage and mileage after 
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broken chainage. 

 Edit/Delete: You can long press the broken chainage data in the list to edit or 

delete. 

10.1.2 Horizontal Alignment 

Horizontal alignment contains straight lines, curves and spirals. The following show 

two methods to edit.  

 

A. Use C/L method to edit alignment: After build C/L method road, go to horizontal 

alignment.  

   

• Import: You can import horizontal alignment file, the C/L method can only 

import the C/L file, and the PI method can only import the PI method file, the file 

format is *.pqx. 

a) Standard horizontal alignment(*.pqx); 

b) Horizontal alignment from Surveyor software(*.xls);  

c) Horizontal alignment from Surveyor software(*.txt); 

 

• Settings: Set interval for station, default is 20m;  

• Save: Save data after edit;  

• More: Clear all data;  

• Preview: Preview the road on map, main points (element changed), stake points 

(based on setting interval) and station check (mileage to point/point to mileage).   
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• Click  to add alignment element.  

  

  

Add Start point: enter start point coordinate and start station. 

Add Line: enter azimuth and line length. 

Add Curve: enter radius, length, and select curve direction (left/right). 

Add Spiral: enter start radius, end radius, spiral length and select spiral direction 

(left/right).  

 

B. Use PI method to edit alignment: After build PI method road, go to horizontal 

alignment.  

  

• Import: You can import horizontal alignment file, you can import horizontal 

alignment file, the C/L method can only import the C/L file, and the PI method 

can only import the PI method file, the file format is *.pqx, or you can import the 



Survey Master Quick Guide 

70 
 

straight curve table directly. 

d) Standard horizontal alignment(*.pqx); 

e) Horizontal alignment from Surveyor software(*.xls);  

f) Horizontal alignment from Surveyor software(*.txt); 

 

• Settings: Set interval for station, default is 20m;  

• Save: Save data after edit;  

• More: Clear all data;  

• Preview: Preview the road on map interface and check stations, refer to C/L 

method.  

• Click  to add alignment element.  

  

  
Add Start point: enter start point coordinate and station ID. 

Add Curve: enter coordinate of intersection point, also curve radius. 
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Add Spiral: enter coordinate of intersection point, also spiral in/out length and 

spiral radius.  

Add End point: enter end point coordinate.  

 

C. Coordinate method 

 

Use Coordinate method to edit alignment: After build Coordinate method road, 

go to horizontal alignment. 

 Import: Import horizontal alignment data. If there is already horizontal 

alignment data in the list, when you click Import, it will prompt that” The 

original data will be cleared before importing data.  Are you sure to 

continue importing?” 

a) CANCEL: then the data import will be canceled;  

b) OK: it will clear the existed horizontal alignment data and jump to the 

horizontal alignment data import interface.  

 

You can import the following horizontal alignment: 

a) Standard horizontal alignment in the coordinate method(*.pqx); 

b) Horizontal alignment from Surveyor software(*.xls);  

c) Horizontal alignment from Surveyor software(*.txt); 

     
• Settings: Set interval for station, default is 20m;  

• Save: Save data after edit;  

• More: Clear all data;  

• Preview: Preview the road on map interface and check stations, refer to C/L 

method.  

• Click  to add alignment element.  

1) Straight line: input the start coordinate and end point coordinate, the 

software automatically calculates the distance; 

2) Arc: input the start coordinate, end point coordinate and radius, the software 
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automatically calculates the length of the circular curve; 

3) After adding, you need to check that the end of each piece of data must be 

consistent with the starting station number of the next section (except for 

broken chainage).  

 

     
 

10.1.3 Vertical Alignment 

Vertical alignment contains grade breaks. 

    
• Import: You can import vertical alignment file with specific format;  

a) Standard vertical alignment(*.pqx); 

b) Vertical alignment from Surveyor software(*.xls); 

c) Vertical alignment from Surveyor software(*.txt); 

d) Vertical section design line from Road Star software(*.xls) 

• Save: Save data after edit;  

• More: Clear all data;  
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• Preview: Preview the road on map interface and check main points;  

 

• Click  to add alignment element, including grade point station, grade point 

elevation and radius. 

 

10.1.4 Standard Cross Section 

Cross section contains horizontal offsets.  

    
 Import: You can import cross section files. If there is already cross section data 

in the list, when you click Import, it will prompt that” The original data will be 

cleared before importing data.  Are you sure to continue importing?”  

a) CANCEL: then the data import will be canceled;  

b) OK: it will jump to the cross section import interface, if you import the new 

data, it will clear the previous cross section data first and then import the new 

cross section data, but it you don’t import the cross section data, the previous 
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data will not be cleared.   

Survey Master supports four kinds of cross section data. 

d) Standard cross section(*.hdm): This is designed by ComNav, when you add 

the  cross section, this is the default format. 

e) Standard cross section from Road Star software(*.xls). 

f) Plate superelevation and widening parameters from Surveyor software(*.xls) 

g) Plate superelevation and widening parameters from Surveyor software(*.txt)  

 

• Apply: Apply the cross section to the road, the data will be saved in the path: 

Sinognss/sm/Road.  

• Delete: When you click , you can click the corresponding data. 

• Edit: Click the cross section data in the list, you can edit the data.  

• Add: Click  to add cross sections: Select a section type, enter section width, 

slope and height difference, the default cross section data is *.hdm format. 

    
h) Section name: You can choose motorway, non-motorway, pavement, hard 

shoulder, earth shoulder, central divider, lateral zoning.  

i) Standard section width:  Enter the current section width, the unit is meters;  

j) Cross slope: Enter the cross slope of the current lane, downhill from the 

design line to both sides,  you don’t need to enter %. 

k) Height difference: Relative to the height difference of the previous lane. 

1) Above the previous lane: positive value; 

2) Below the previous lane: negative value. 

e)   Mirror Image: You can design left section and right section respectively. If 

the left section and right section are symmetrical, you can only design left 

section or right section, then click Mirror Image, then it will get the same 

section on the right section or left section. 

10.1.5 Super-elevation 
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Superelevation means that when the train is running on a circular curve, the lateral 

force or centrifugal force will cause slippage. In order to offset the centrifugal force 

generated when the vehicle is running on the circular curve section, it can ensure 

that the train can be safe, stable, and meet the design speed and economically and 

comfortably pass the circular curve, the outer side is higher than the inner side one-

way cross slope on the cross section of this road section. 

 

 Add:  

a)  Add the stake mark of the superelevation change point; 

b) Add the cross slope of the superelevation change point (standard section 

slope, no need to enter %, downhill from the design line to both sides, downhill 

is negative, uphill is positive) 

c) Change mode: supports Linear and Cubic parabola. 

     

 Import: If there is superelevation in the list, when you click import, it will prompt 

that” The original data will be cleared before importing data.  Are you sure to 

continue importing?”  

a) Cancel: Cancel to import superelevation data; 

b)OK: it will clear the existed superelevation data and jump to the superelevation 

data import interface. 

Survey Master supports 4 kinds of superelevation data. 

a) Standard corss section-Superelevation data(*.hdm); 

b) Superelevation from Road Star software(*.xls). 

c) Superelevation parameters of the plate from Surveyor software(*.xls) 

d) Superelevation parameters of the plate from Surveyor software(*.txt) 
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 Save: When you add, edit and delete superelevation data, click Save button to 

save the change, the data will be stored in the path Sinognss/sm/Road. 

 Edit: Click the data in the list, you can edit the data value. 

 Delete:  Click   to delete the corresponding data. 

 Explanations: 

 The superelevation data will be stored in the *.hdm file under the path Sinognss/sm/Road, 

you can open it with Notebook. 

 Here is an example of superelevation data.  

1) The first column: “0” means that the data in this row is superelevation data, if it is "1", it 

means that it is widening data. 

2) The second column: represents the pile of superelevation change point, the order is from the 

main section in the left section of the standard cross section to the end of other plates on the 

right plate (i.e. the main plate on the left--other plates on the left--the main plate on the 

right--other plates on the right); 

3) The thirs column: the cross slope value of the superelevation change point (From the design 

line to both sides, downhill is negative, uphill is positive); 

4) The fourth column: the variation of superelevation, "0" represents linear, "1" represents cubic 

parabola. 

 

 

10.1.6 Widening  

Widening means that when the car is driving on a curve, the driving trajectory of 
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each wheel is different. The radius of the rear wheel on the inner side of the curve is 

the smallest, and the radius of the front wheel near the outer side of the curve is the 

largest. This phenomenon is more prominent when the turning radius is small. In 

order to ensure that cars do not encroach on adjacent lanes when turning, all curved 

sections with a radius of less than 250m need to be widened. 

 

 Add:  Find the widening change point and input the widening data. 

a)  Add the pile of the widening change point; 

b)  Add a width of widening change point; 

c) Variation method: Linear, Cubic parabola, Quadratic parabola;  

1) Linear: Gradually widen in proportion to its length within the scope of the 

widening transition section, which can be used for second, third and fourth class 

highways; 

2) Cubic parabola: use high-order parabola within the scope of the widening 

transition section, suitable for expressways and first-class highways that have 

certain requirements for road capacity; 

3) Quadratic parabola: use a circle in the widening transition section, suitable 

for highways and suburban sections of first and second-class highways; bridges, 

viaducts and other structures; and sections of various safety protection facilities. 

      

 Import: If there is widening data in the list, when you click import, it will prompt 

that” The original data will be cleared before importing data.  Are you sure to 

continue importing?”  

a) Cancel: Cancel to import widening data; 

b)OK: it will clear the existed widening data and jump to the widening data 

import interface. 

Survey Master supports 4 kinds of superelevation data. 

a) Standard corss section-Widening data(*.hdm); 

b) Widening data from Road Star software(*.xls). 

c) Plate widening parameters from Surveyor software(*.xls) 
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d)Plate widening parameters from Surveyor software(*.txt) 

    

Explanation: 

1. The widening data is stored  in a ***.hdm file in the default location and can be 

opened with just Notepad. 

 

The widening data is the same as the superelevation data, divided into four columns 

1) The first column: "1" means widening data, if "0" means superelevation data; 

2) The second column: the station number of the widening change point, the order is 

from the main plate in the left plate of the standard cross section to the other plates 

in the right plate (that is, the main plate on the left--other plates on the left- -The 

main section on the right--other sections on the right); 

3) The third column: the width of the widened change point (the widened width);  

4) The fourth column: the widening gradient mode, "0" represents linear, "1" 

represents cubic parabola, and "2" represents quadratic parabola. 
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Tips:  

1. Both the widening data and the superelevation data are included in the cross-section data, 

generally below the superelevation; the order from top to bottom is the left main section 

superelevation--left main section widening--left The other plates are superelevation--the other 

plates on the left are widening--the main plate on the right is superelevation--the main plate on 

the right is widening--the other plates on the right are superelevation--the other plates on the 

right are widening. 

2. The data not framed in the figure are cross-section data. 

10.2 Road Stake 

10.2.1 Road Settings 

Go Road stake—Settings--Road.  

 

Current mileage stake: if check on the option, 

means no target station, go whatever mileage 

show station on centerline;  

Station ID: enter the station for current stake;  

Middle stake: check on the option refers to save 

points in stake point list, otherwise save in cross 

point list;  

Spacing/Cross: define the offset value;  

Cross section line: define the length for the 

guideline of right/left cross;  
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10.2.2 Stake Alignment 

Go Road stake, it will auto add the start point of the road to the target stake point, 

follow the navigation information shown on the map, when go near the target point, 

the map will show big circle as below, and when the accuracy high enough to stake 

the point, Survey Master will alarm to let you know, then press measure icon to 

finish this point stake.  

 

10.2.3 Stake Cross Section 

Go Road stake, check Cross section option. The red line shows cross section direction.  

 

10.2.4 Road store 

Go Road store to check the stake point and the cross point, export the data as you 

required.  

Settings 

Element: stake/cross points 

Search: search stake points 

by mileage and cross or 

point coordinates. 

Layer 

Zoom extents 

Back to current location 

 

Cross: Distance from current to cross section;  

Y Offset: Along the alignment the distance 

from current to cross;  

Dig: Elevation difference from current to 

designed elevation. 
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11 Element 

The points, which are surveyed, staked, added, imported, and input from Basemap 

(refer to Chapter 12.3), will be stored in Element. The surveyed points will be shown 

under one base while surveying. Also, no matter where you need to select a point, all 

the points of the Element are available. 

 

⚫ Symbol descriptions 

Symbol Description 

 
Base point 

 
Survey point 

 Auto survey point 

 Input point 

 
Control point 

 
Stake point 

 
Road middle stake point 

 
Road cross point 
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⚫ Base: p11(Base): This shows the coordinate of base station, the base type 

includes auto base and fix position.  

⚫ Stake: Select one point and click Stake, then go to Stake point interface to stake 

point(pls refer to Chapter 6.4). 

⚫ Detail: Select one point and click Detail button, you can check more details 

about this point. 

⚫ : Image tag, you can add the picture for the surveyed point, currently 

supports one picture for one receiver, you can add the position info, draw 

something, add notes for this picture, if you add a picture for one point, it will 

show picture on the Element list. The picture is stored in the path: 

Sinognss/sm/project/ specific project/ media. 

     
⚫ Search: Click Search and enter some key words, it will show you the points you 

need. 

⚫ Add: Supports to add Input Point, Control Point and Stake Point, and Display type 

Supports Local grid coordinate and WGS84 LatLon. 

⚫ Switch display mode: There are two display modes of points, the first one can 
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show both Local grid coordinate (NEZ) and WGS84 LatLon coordinate (BLH), you 

can swipe the screen to check the detail of the point; the second one can only 

show one form of the coordinate, Local grid coordinate (NEZ) or WGS84 LatLon 

coordinate (BLH). 

⚫ Coordinate type: Support Local grid coordinate (NEZ) and WGS84 LatLon 

coordinate (BLH), in the form of the second display mode, you can click this to 

the change coordinate type display.  

⚫ Multi-select: Select one point, then click Multi-select to choose multiple points; 

in the first display mode, you can also long press the point name to select 

multiple points.  

   

  

Click Detail to check the information about the base coordinate. 
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The information includes message type, station type, WGS84 Coordinate, Local 

grid coordinate, known point coordinate (only Fix position base)and Base offset 

parameters(only Auto base). 

Message type: differential data type, depends on the differential data 

transmitted from the base. 

Station type: includes Auto base and Fix position base. If you started Auto base, 

you can change to Fix position base and enter the Known point coordinate and 

antenna height; if you started the Fix position base, then it will not be allowed to 

change to Auto base. 

    

Base offset parameters: If you want to change Auto base coordinate to a 

control point or a known point, or do some adjustment, you can enter the △x, △y, 

△h, then the base coordinate will make a adjustment, or you can do grid shift(see 

Chapter 13.5) 

12 Data Export/Import 

Survey Master supports to import/export data including grid coordinate, Lat/Lon 

coordinate with various data format, support import DXF/DWG file and export result 

of DXF/KML. 

12.1 Import points data 

Tap Import in project interface, there are some predefined data formats, click More 

formats to get more predefined formats. Besides, you can click Add to create a User-

defined type. 
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Long press the predefined data format that you don’t use  often, you can move this 

format to the More formats page; also, you can move the data format of More 

formats page to the previous page where stored the formats you usually use. 

   

• Name: Enter the name for the format 

• Delimiter: support Comma(,), Space( ), Semicolon(;) 

• File format: support *.csv, *.dat, *.txt format 

Click Select all to choose all elements, Click Clear to eliminate all elements selected. 

 

The elements include: code, name, N, E, Z, B, L, H, X RMS, Y RMS, V.RMS, status, 

start time, occupation time, diff age, base ID, total AntHgt, Antenna height, 

measure type, antenna name, ending time, comment, RMS, PDOP, HDOP, VDOP, 

TDOP, GDOP, total SV, used SV, elevation, tilt offset, tilt angle, tilt distance  

 

Tip: The format you defined will also be saved to Export interface. 
 

Choose one format to import data. 

• The default export path is …/Sinognss/sm/data, you can also click Upper folder 

to change to any other path where the file is.  

• Point type: support Input point, Control point, Stake point 
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12.2 Export result 

Tap Export in Project interface to export simple data of survey points. Also, click 

More formats to export the survey points with detailed information or other formats 

like stake points/lines, DXF, SHP, KML, RAW, RW5, HTML, CASS feature result. 

Same with Import result, long press the predefined data format to select the 

interface you want to place. 

    
• File format: support *.csv, *.dat, *.txt format 

Choose one format to export data. 

• Select: support Survey point, Control point, Input point, Stake point, Base, also, 

you can set the date, name, code of data to specific export  

The default export path is …/Sinognss/sm/export, and the previous saved file will 

be shown below, you can also click Upper folder to change to any other path.  
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For the points, lines and polygons you surveyed in Topo survey and Feature survey, 

you can click Export DXF to export dxf file, then you can edit them in third party 

CAD software, or import to Basemap to check, or import to Stake CAD to stake. 

Choose the data that you want to export including survey point, input point, 

control point, stake point, base, line and polygon, and the layer properties includes 

name, code and height, the default text height is 0.5.  

 

12.3 Import Basemap 

Tap Basemap to import DXF/DWG/SHP file into Survey Master. 

• Add points: Save points from the dxf/dwg/shp file to element. 

• Add lines: Save lines from the dxf/dwg/shp file to element. 

• Prefix: Support add prefix name for points/lines saved to Elements. 

• Add line endpoints: add line endpoints to point element. 
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If you want to display basemap in the Survey and Stake surface, you need to go 

survey settings to check on display basemap, click zoom button to auto show 

basemap. 

    

 

12.4 FTP for data management 

This function allows user log in PC to management/download the controller data file. 

Make sure the controller and PC connect with a same WLAN, go SM start FTP and 

enter the address on File resource manager or browser, it will show all files on 

controller.  
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• Enter the ftp address in File resource manager: 

 

• Or enter the ftp address to browser: 
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13 Frequently used Functions 

This chapter will show some frequently used functions, including Device Information, 

Site Calibration, Grid Shift, COGO, NMEA 0183, Code and Receiver Register function. 

13.1 Cloud Login/Register 

Users can easily register and login an account with phone number all around the 

world. Once login, users can share data including Project, Datum and work mode any 

time. For more, the remote assistance function is based on login an account. 

13.1.1 Login/Register 

Use phone number to register and login. 
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13.1.2 Cloud upload/download 

Login the same account, tap upload/download to share project, datum and work 

mode.  

   
 

13.1.3 Remote assistance 

Users who need help need to connect to server as below, then helper in background 

can help. 

Remote help from Cloud. The helper login NaviCloud address to help. 
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Ask remote from a friend: helper can connect your receiver by Remote connection 

with Survey Master.  

   

13.2 Device Information 

Go Device info, click to check Register, Device Info, Status and any other information 

of the device after connecting Bluetooth.  
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13.3 Position information 

Tap Positioning to check the position info.  

Check receiver firmware 

Freset: Reset receiver to factory 

Restart: Reboot receiver  

Firmware update: Choose firmware to update  

Disconnect: Disconnect with the receiver  

Check receiver work mode 

Check receiver battery power 

Check receiver register status 

Check receiver model: T300 Plus, and hardware ID: T33  

Check receiver solution mode: Reliable mode as default 

Auto start: Only some receivers supports: T30 IMU and N5 on 

K7 platform, all K8 receivers 

On: receiver will turn on automatically when connecting to 

external power; 

Off: receiver will not turn automatically when connecting to 

external power. 

For K8 receivers: 

there are OS firmware, GNSS firmware, radio firmware, and 

panel firmware (only N5 has) 
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Tap BASE to check the Base info and navigate to Base. 

 

 

Tap SATELLITE to check the satellites info, including the sky view, SNR and satellite 

list for detailed information.  

In addition, you can uncheck to lockout the satellites constellation directly, and if 

you want lockout some satellites, close the satellites from the list to lockout. 

Geoid shift: Add EGM model will show the shift value 

Tilt offset: Receiver with tilt sensor after calibration 

will show the magnetic strength value. 

Diff delay: show how long the rover gets differential 

data from base 

Check Base station coordinate and the distance 

to Base station 
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13.4 Site calibration 

Site calibration is commonly needed once in one project, and all the points will be 

collected based on calibrated datum system. 

1. Choose manual pair or auto pair.  

             

2. If you choose manual pair, you can directly enter at least three groups’ point to 

compute. (for example, take K1,K2,K3 as known points, take A1,A2,A3 as 

measured points) After click Compute to calculate, the software will calibrate 

automatically. 
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3. If you choose auto pair, it will auto compute according to the same name for 

known point and measured point. After click Compute to calculate, the software 

will calibrate automatically. 

       

   

4. Click Apply to confirm to replace datum. The value of H.Resid and V.Resid should 

meet the requirement (H.Resid ≤ 0.015m, and V.Resid ≤ 0.02m). 

Click to add 

K1, K2, K3 

Click to add 

A1, A2, A3 
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5. It also supports import and export LOC files, which is convenient for customers 

to use. 

13.5 Grid Shift 

Grid shift function is applied when you need to change the position of Base station in 

the same project. 

Click Grid Shift in Tool interface -> add current Base point and target Base point -> 

Click Compute-> Apply to complete grid shift, all rover points will upgrade the 

coordinate. 

   

After grid shift, the grid shift value △x,△y,△h in the base detail from Element will 

be changed, you can also set the △x,△y,△h to zero, which will cancel the grid 

shift settings.  

Click to add the point from one Base 

Click to select the same point from another 

Base  
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Tips: The fix position base will not be allowed to do grid shift, because we can’t shift the measured 

point. 

13.6 COGO 

With COGO function, you can calculate points/lines/angle directly on field.  

              

• Angular transformation: Angular type transform; 

• Two points: Calculate two points distance; 

• Point to line: Distance from point to one line; 

• Offset point: Calculate point with azimuth and distance; 

• Deflection angle: Calculate angle of two lines; 

• Deflection point: Calculate point with angle and distance; 

• Intersection point: Calculate intersection points from two lines; 
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• Bisection point: Calculate point from angle bisector; 

• Points from line: Calculate points on line by distance or segment; 

• Point average: Calculate average from points; 

 

13.7 Mock Location 

Mock Location is a function for sharing the Survey Master accuracy to your 

controller/smart phone, so that ComNav receiver can work with third party software. The 

function is suitable for users who prefer some third-party software rather than Survey 

Master, then can take ComNav receiver and their own software to conduct work.  

 

Step 1: Enable Mock Location in Survey Master 

For users who need RTK accuracy, please follow the previous chapters to get RTK fixed 

firstly, then go Project→Settings, check Mock Location option, and leave Survey Master 

Software run in background.  

    

 

Step 2: Enable Mock Location for controller/smart phone 

For many Android devices, they can get position from internal GPS/GNSS chip and 

Wi-Fi network but not accurate (generally less than 10 meters), so you need to 

enable mock location on to get position from Survey Master.  

 

• Firstly open Settings on your controller/smart phone. 

• Scroll down to bottom and select About Phone. 

• Scroll down and find Build Number option, click seven times on Build Number 

to make sure you are in developer mode. 

• Also in Settings, select System&updates, then find Developer Options and open 

it. 
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• Normally, you just need to enable Allow mock locations on. And in some devices, 

you need Select mock location app, then select Survey Master Software. 

    

Step 3: Go third party software 

13.8 NMEA 0183 output 

With NMEA 0183 function, you can quickly set to output NMEA data from com1 port 

or Bluetooth. In fact, this function is same as enter commands “log comX gpXXX 

ontime X”. 

Choose NMEA Port -> Baud -> check commands you want to output. 

  

 

Data transfer: for transmit all the BT output to the address. 

Log com1 gpgga ontime 1 

This option is same as 

the command 

“saveconfig”. 
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13.9 Code List 

This is a function for adding or managing the code. You can add the code for point, 

line and polygon by grouping. After add a code list what you need, it will be 

convenient to use Topo Survey, Feature Survey and nine-panels function. In addition, 

the description of code is good for you to survey features. In some situation, code 

will be easy, so you can select the description to know what you are surveying. 

Step 1: Add a code list 

If you don’t have a code list, you can modify current code list and add the code, if 

you add a code list before, you can choose this code list when you create a new 

project. 

      

• Modify: You can modify the current code list, support modify previous code 

detail and add a new code to it. 

• Import: select the TXT code list file what you need to import . 

• Add: Add a code list 

• Delete: delete the code list 

• Export: Export *.txt file of the code list 

 

Step 2: Add the code for point, line and polygon by grouping  

Click Group -> Add group, input group name-> Add the code for point, line, polygon-> 

choose group, type, style for the code. 
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Tips:  

1. When you add a group in the point interface, it will not apply in line or polygon interface. 

2. You can enter a new code in the Survey and Stake surface, when you survey the point, the 

code will be stored in the current code list. 
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13.10 Register Receiver 

Normally, the register code is like this:  

ID:03311982    $$:49-18-76-14-00-00-00-36-21 

FUNCTIONREG:2091007494-0446840386-3349298772-3600957130-3684843029-

2463744780 

Note: The code length is different for different functions. 

 

Following shows two methods to register the receiver. 

13.10.1 Register Menu 

For Register function, you need only enter the number: 2091007494-0446840386-

3349298772-3600957130-3684843029-2463744780 

    

13.10.2 H-Terminal Menu 

You need copy the whole code, include the word ‘FUNCTIONREG:’ 
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FUNCTIONREG:2091007494-0446840386-3349298772-3600957130-3684843029-2463744780 

  

 

14 Surface 

This is a function for adding and managing the surfaces. The surfaces in this Surface 

library can be staked directly in Stake Surface. 

Copy the whole code, 

and enter the cursor to 

next line, then send. 

Send command: LOG REGLIST  

To check receiver register status. 
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1. Search: Enter the surface name or key words in the search bar to search the 

corresponding surface; 

2. Stake: Select a surface in the table and click Stake to stake the surface, please 

refer to the Chapter 6.4.3; 

3. Delete: Select one surface file in the table and delete surface; 

4. Preview: Choose one surface in the table and preview the surface; 

5. Add / Edit 

When you add a surface, you need to enter a surface name; Go to the Element to 

choose point to form the surface, you can search the point with the key word, or 

select all points. The algorithm to form the surface is Delaunay triangulation, the 

boundary is defined according to the convex hull algorithm. 

After you finished creating the surface, you can preview the surface shape and size, 

and click Save to save the surface. 
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7. Save/Delete: When you create or edit the surface, you can long press the point on 

the list, and delete the point from the list, after you create or edit the surface, you 

can click the Save to save the creation or edit.  

6. Import / Export: 

Survey Master supports to import the surface in .xml and .sjw format, and supports 

to export the surface in the .sjw format, the default path is /Sinogns /sm/Export.  

Tip: The surface format suffix should be lower case letters, the .XML file cannot be imported 

successfully. 

 

15 Rinex Convert  

Survey Master supports to convert the static data CNB files to Rinex format, you need to put 

the CNB files which you want to convert in your controller root first, or you can choose the 

static data logged by Static Survey via Survey Master, the default path is /Sinognss/sm/Raw. 

The supported Rinex version includes Rinex2.10, Rinex2.11, Rinex3.01, Rinex3.02, Rinex3.03, 

Rinex3.04; the supported Auto, 1s, 2s, 5s, 10s, 15s, 30s, 60s,  Auto means it will be same 

with the CNB sample interval. 

The converted Rinex file will be stored in the same place where the CNB file is, the 

observation and all ephemeris data will be compressed into one file. 
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If you have already converted the file, when you converted again, it will pop up that the file 

name exits and need to change name.  

16 FW Update 

In Survey Master, you are allowed to update the receiver firmware, but it only supports 

firmware in *.bin format. 

 

If you want to update the firmware for your receiver, you need to copy the firmware to your 

controller first, connect your receiver to the Survey Master, then go to the Device->FW 

Update, choose the firmware in your controller folder.  

 

Go to Device Info-> Firmware Update, or click the FW Update on the main interface, go to 

FW update interface, click Start, it will take about 10 minutes to finish the update. After you 

finish the update, you need to restart the receiver. 

    

 

Tips: 

1. Please make sure the power of the controller and receiver more than 30%; 
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2. Don’t power off the receiver or exit software during update! 

3. The current receiver hardware and firmware determine whether the FW upgrade function is 

available. Different receivers have different rules, for more information, please refer to their user 

guides. 

17 Earthwork Calculation  

Earthwork volume is one of the main data of the earthwork construction organization design. 

It is the basis for the organization of labor when manual excavation or the calculation of 

mechanical shifts and construction period when mechanical construction is used. Earthwork 

calculations should be as accurate as possible. 

 

Earthwork calculation includes the total amount of filling and excavation. The calculation 

method of earthwork is: take the distance between two adjacent cross-sections as the 

calculation unit, that is, obtain the area of the subgrade on two adjacent cross-sections and 

the distance between the two cross-sections respectively. 

 

In Survey Master, the algorithm for forming the surface is the Delauny Triangulation, he 

boundary algorithm is the convex hull algorithm. 

 

Go to Tool->Earthwork Calc, enter the Earthwork calculation interface. 

 Surface: This surface is the original ground, the target surface for excavation or filling 

volume, which is stored in the Surface library, for more information, please refer to 

Chatper 14; 

 Reference elevation: This is the design elevation, it will calculate the excavation or 

filling  volume on the original ground according this elevation; 

 Reference point: You can get the reference point from Element or directly survey a 

point, it will calculate the excavation or filling volume according to the reference point 

elevation. 

 Reference surface: This is the design surface, it will calculate the excavation or filling 

volume between the design surface and the original ground. 

 Compute: Click Compute to get the excavation or filling information. 

 Export report: This will export the earthwork calculation report, the format is *. HTML, 

the default path is Sinognss/sm/Export. 
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18 OEM board interface 

This part is used for board testing or developers. This interface will appear when the 

corresponding board is connected. The following introduction takes the K8 kit as an 

example. 

18.1 OEM board main interface 

Connect Device: If you want to switch devices, you can click [Home]→[Connect 

Device], as shown in Figure 3-2 to connect the device, click “Disconnect” to 

connect to other devices. 

Differential Settings: You can view the current mode and set the current working 

mode. Currently, only the handbook network working mode setting is supported. 
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Connect Device: If you want to switch devices, you can click Home→Connect Device, 

and connect the device, click “Disconnect” to connect to other devices. 

Differential Settings: You can view the current mode and set the current working 

mode. Currently, only the PDA CORS working mode setting is supported. 

Device Information: You can view the device model, S/N, firmware version, data link 

and other information, click the "Data Link" column to connect or disconnect the 

working status, or restore the factory settings. 

Position Information: View the BLH value, differential status and other values of the 

current device location, as well as base station information. 

Remote Assistance: After entering the remote assistance interface, log in with the 

user account and password, and use cloud services. 

Settings: After entering the software setting, you can perform operations such as 

shortcut key setting, sound setting, unit setting and interface style.  
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18.2 OEM board satellite 

Sky view: GPS, BDS, GLONASS, GALILEO are checked by default, and if a certain type 

of satellite is blocked, then differential signals are no longer used in satellite solution. 

SNR: Displays the current SNR value graph, the middle green line represents the best 

L1 value, and the red line represents the best L2 value. 

 List: The displayed contents include serial number, satellite, azimuth, altitude, L1/B1, 

L2/B2, L5/B3.  

     

18.3 OEM board data 

Go to Data->NMEA, 

1) Output port: default com1, Bluetooth can be selected. 

2) Baud rate: default 115200, selectable from: 4800-115200. 

3) Restart the receiver to output normally: Indicates that the output settings are 

saved, and the message is still output after restarting the receiver. 

4) Output message: Select all to default to all messages, or select GPGGA, GPRMC, 

GPGLL, GPVTG, GPGRS….click “OK” to complete. 

5) Data forwarding: Enable data forwarding, enter the server and port, and the 

current receiver message will be forwarded to the server. 

 

Data->Terminal: Send commands to the board through the terminal to operate the 

receiver. When you send commands by inputting relevant commands, the command 

input has the function of automatic completion. (Whether the command is valid or 

not depends on whether the current connected hardware supports it).  



Survey Master Quick Guide 

112 
 

   

Data->Terminal: Send commands to the board through the terminal to operate the 

receiver. When you send commands by inputting relevant commands, the command 

input has the function of automatic completion. (Whether the command is valid or 

not depends on whether the current connected hardware supports it).  

 

Data->Terminal: Click the Clear button to clear the current interface; click the Pause 

button to stop the current interface scrolling; click Save to store the test data in the 

custom path. Click the command to pop up the command set, the first line is the new 

command set, and the rest are the defined command sets. 
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19 Settings  

Go to Project->Settings, 

   

 Auto connect: It is used to connect automatically after the Bluetooth is 

disconnected, and when the software restarts, it will automatically connect to 

the last receiver mode. 

 Automatically enter kboard mode: This is used to enter the OEM board mode, 

this option is checked on by default, for the kboard information, pls refer to 

Chapter 18, if you enter the kboard by mistake, you can Exit the kboard mode in 

the Settings. 

 Mock location: You can check or uncheck the simulated location. If you check 

the simulated location, you can view the simulated location information in the 

device (English version only), for more information, pls refer to Chapter 13.7. 

 Display: It can be switched from NE to EN and can be selected according to the 

user's need to display. After selection, the corresponding coordinate display 

mode will be displayed in the status bar of the main interface. 

 Sound: The engine setting allows the user to choose a suitable voice engine. The 

voice broadcast is to broadcast the connected equipment and real-time 

differential status; the sound is to remind when the measurement accuracy of 

the stakeout does not meet the conditions or when the stakeout reaches the set 

range. 

 Language: support switching between Chinese, English, French, Turkish, Polish, 

etc. 

 Hot Key: You can set the volume key "+" or "-" as the measurement button, the 

previous point, and the next point. 

 Units: The length unit can be switched between meters or feet; the angle unit 

can be switched between degrees or degrees, minutes and seconds; there are 
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five kinds of export precision, and the minimum export precision is five digits.  

 Interface style: switch between minimalist blue and colorful circles. 

 Theme style: Support Nine-panel and Simple types. 

 Screen orientation: Auto, landscape or portrait, the default is portrait 

 Feedback: Select the type of feedback question, enter your comments or 

suggestions on the Survey Master software and existing bugs, provide the 

contact information and submit it, and the relevant personnel will receive the 

feedback information. 

 Share and rate: Scan the QR code to get the software; click Share to share to the 

relevant software system; click Rating to enter the application software to 

evaluate the measurement master. 

 About: the current version update log information, company contact number, 

company official website, disclaimer information, check whether there is an 

update, click "Update" to download the latest version for installation when 

there is an update; double-click the icon of Survey Master to open the log. 

   

Technical Assistance 

If you have any question and cannot find the answer in this manual, please contact 

us from ComNav Technology Website: www.comnavtech.com 

or technical support email: support@comnavtech.com 

Your feedback about this manual will help us improve it with future revisions. 

http://www.comnavtech.com/
mailto:support@comnavtech.com

